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What is Banner? 
 
BANNER is an administrative software application developed specifically for higher education 
institutions by Systems and Computer Technology Corporation (SCT).   
 
BANNER a system, which in turn are made up of modules, each of which handles a major 
function. For example, the Finance system modules include General Ledger, Stores Inventory, 
Purchasing, Accounts Payable, Budgeting, Accounts Receivable, Fixed Assets, and Grants. The 
Human resource modules cover functions such as Payroll, Benefits, Applicant Tracking, Position 
Control, and COBRA. Modules for the Alumni system include Campaigns, and Gift and Pledge 
Processing. Some of the Student system includes, Admissions, Scheduling, Registration, and 
Academic History. 

New Mexico Highlands University (NMHU) purchased and maintains five modules which are: 

• FINANCE  
• ALUMNI DEVELOPMENT  
• STUDENT  
• FINANCIAL AID  
• HUMAN RESOURCES  
• GENERAL  

 
The systems are highly integrated because they all share a common database. This common 
database is shared by everyone who uses BANNER at NMHU, which makes it easy to maintain 
records.  Because of the common database, multiple departments use the information entered 
into BANNER. Other departments share data, sometimes several years in the future. (See 
NMHU's Data Entry Standards) For example, a name change would be reflected in the Student, 
Financial Aid, Human Resource, and Alumni systems. 
 
Though information on BANNER is shared, many users are allowed only to look up (query) 
specific information. When you perform a query, you retrieve information from the database and 
display that information on the screen. BANNER has a variety of tools that let you search for a 
record and automatically retrieve associated information. 
 
Technically, data is not actually stored in BANNER. Data is stored in a powerful database called 
ORACLE. It would be difficult for a non-technical user to directly add or retrieve data from the 
actual database. The BANNER software acts as an interface to the ORACLE database, making 
the job of adding or retrieving data much easier. BANNER provides the features and processing 
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capabilities needed for student information (admissions, registration, etc.), alumni information 
(sponsor identification, campaign management, etc.), personnel information (employee benefits, 
salary/deduction history, etc.), financial aid information (needs analysis, packaging, etc.) and 
finance information (general ledger, accounts payable, accounts receivable, etc.). 
 
BANNER also has sophisticated security measures to make sure that only authorized individuals 
have access to specific data. 
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New Mexico Highlands University 
 

NOTICE TO BANNER SYSTEM USERS 
 

All Information in the New Mexico Highlands University 
BANNER Database System is Confidential 

 
 
Banner Confidentiality Statement 
 
As a New Mexico Highlands University employee who will use the BANNER System, you will 
be able to access confidential information on employees, students, alumni, donors, and vendors.  
Much of the information in the BANNER System is protected from disclosure by law.  This 
information is to be used solely in the performance of your job and not for any other reason. 
 
You are not to disclose to anyone your password to the BANNER System.  An employee who 
discloses his or her password, who uses the BANNER System for the purposes other than for the 
performance of his or her duties, or who provides information from the BANNER System to any 
individual or organization for reasons unrelated to the performance of his or her job will be 
subject to disciplinary action. 
 
System Security Rules 
 

1. Passwords are confidential.  Employees are to use only the username issued to them. The 
use of another employee’s username or allowing another individual to use their username 
is strictly prohibited. 

 
2. PCs are to be logged off or locked at the end of each business day. It is recommended 

that during periods when the employee will be away from their PC for more than fifteen 
minutes.   

 
3. Banner should always be logged out at the end of each business day.  An “open” student, 

employee or vendor record should never be left unattended on a PC. 
 

4. An employee must have a “legitimate education interest” in order to access a student 
record.  The Family Education Rights and Privacy Act (FERPA) of 1974 set this 
standard. 

 
5. Any employee who is not completely familiar with the FERPA, its purpose and the rules 

governing access to student records, please contact the Registrar so that you are provided 
with a written copy.   

 
6. An employee who “signs in” for another person using their own username and password 

will be held accountable for any errors made by that other person. 
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Logging In and Logging Out 
 
How to Log In 
 

Your window desktop will contain the Banner2000 icon:   
 
To open Banner, double left click on the Banner2000 icon to access the Login dialog box: 
 

 
 
Username: Type in your Banner username.  Tab to the Password field. 
Password:  Type in your Banner password.  Tab to the Database field. 
Database:  Pick the database you wish to work in by either taking the default (PROD) or by 
selecting the arrow to the right and view what databases are available (PROD for production, 
PPRD for pre production or TRNG for training). 
 
Note:  Your Username is your network ID. 
 

Click  to log in to the Banner system.  Click  to abort the login process. 
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If you see the following dialog box, it can mean one of three things.  
 

 
 

• You did not type in your username or password correctly. 
• You are trying to connect to a database that you are not set up for. 
• You do not have a banner account. 

 
Training (TRNG) database is an area that user are first given access to.  The data in training was 
generated by SCT/Banner and is used by Banner Trainers.  To access training use the username 
of train01 and a password of train01, train01 has access to all forms so you can try them out.  
Pre-production (PPRD) is clone of production, this is where you should try out new things before 
doing them in production.  You would use your normal username and password to access pre-
production.  Production (PROD) is the real database, only do real work here.  You would access 
production with your normal username and password. 
 
If you see the following dialog box, it means that you have put in a database name that does not 
exist. 
 

 
 
If you see the following dialog box, it means that you asked for a database that is not up.  If you 
need it, please call CNSgroup and request that the database be brought up. 
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If you see the following dialog box, it means that you do not have banner mapped on your 
system.  If you go to Windows Explore and pull down the Tools menu, select Map Network 
Drive.  Be sure that the drive letter is S: is selected.  Then put in the path of \\lvhucns\ban4.  
Then try logging into banner. 
 

 
 
How to Log Out (Exit) 
 

Click on the Exit icon on the Tool Bar  to exit a Banner form or Menu.  Once you are on the 
Main Menu, click on the icon again to close Banner.  You will see the following dialog box; 
click Yes to close Banner or No to continue working in Banner. 
 

 
 
Information You Can Access 
 
When you request your Banner username, you will be given access to certain forms based on 
your job function.  Not only can Banner security specify what forms you can use, but also how 
you can use them.  Every user will be given either Update or Query privileges.  This means that 
you will be given authorization to add, delete, or change the information displayed on the form 
(update) or just the ability to view (query). 
 
If you accidentally try to view a form that you have not been given privilege to use, you will see 
one of the following messages: 
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or 

 

Click OK to accept the message on the alert box.  You can either click on a different form or re-
type another form name. 
 
The Banner access process begins with a Banner Team Leader or your supervisor.  Check with 
that individual for more information.  
 
Team Leader for the Modules is as follows: 
 

• FINANCE    Grace Montoya 
• ALUMNI DEVELOPMENT   Darlene Chavez 
• STUDENT     John Coca 
• FINANCIAL AID    Eileen Sedillo 
• HUMAN RESOURCES   Donna  Castro 
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The entire Banner system, from menus to the forms, incorporates a familiar style common in 
many of today’s popular software packages. 
 
Main Menu 
 
The main menu allows you to select from a list of menus, forms, jobs, and QuickFlows in Banner. 

• A main menu that can be resized, customized, and resorted. 
• Direct Access. 
• The ability to choose whether form names, release numbers, and database instances are 

displayed on form title bars. 
• Menu Navigation Pull-Down List. 
• Folder icons on menus. 
• Iconic buttons. 
• Description and Name can be sorted. 
• Left and Right Pane 

 
When you log into Banner, the Main Menu above appears: 
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The main menu provides access to the submenus, forms, jobs and QuickFlows in Banner.  The main 
menu is made up for four parts, the Banner Main Menu, Product links, Go or Direct Access and the Main 
Menu Button Bar. 
 
The main menu has a familiar Windows-style tree structure: 
 

• The main menu displays the Banner products (menus, forms, jobs, and QuickFlows) in a 
hierarchical tree structure. 

• The Product Links at the top of the screen allows you to navigate through the different Banner 
Products.  This is handy if you have the main menu expanded and need to get to something that is 
hidden. 

• Go or Direct Access allows you to access a menu, form, job, or QuickFlow by its name.  The 
Object Search button allows you to search for a form, job, or QuickFlow by only part of its’ 
name. 

• The main menu button bar gives you a quick way to access basic menu functions, such as, Site 
map, return to main menu, and exit. 

Plus Signs and Minus Signs: 

Click on these signs to expand and collapse 
menus within the Banner main menu tree 
structure: 

• Plus Sign (+): Shows that the menu is 
collapsed 

• Minus Sign (-): Shows that the menu is 
expanded 

 
 

 
 
 
 
 

 
Site Map 
 
Selecting the Site Map icon  accesses the Site map.  It lists the top-level menu, plus one level 
below for all of Banner. 
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If you select a menu for the site map, the Main menu appears, displaying the menu you selected 
with one level expanded. 
 
To return to the Main menu without selecting a menu from the site map, select the Menu icon 

. 
 
Customizing Menus 
 
If you have forms, that you use over and over again, you can create a customized menu in the 
My Banner section of the Main menu.  To do this you will need to go to GUAPMNU (should be 
the only item in the My Banner menu if you don’t have one defined yet or type the from name in 
the Go, Direct Access Box). 
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One you have GUAPMNU open, you can select a form from the left side by highlighting it. 
 

 
 

You then press the right arrow button  to move it to the right panel (under your username’s 

menu).  Once you have selected all forms you want for your menu, select the save button  or 
press F10 to save your menu.  If for some reason, you forget to save your changes, you will be 
prompted to do so, before it will return to the Main menu, it this point you can choice to save the 
changes, not save the changes, or cancel out of the exit and return to customizing your menu. 
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You must log off and log back on to Banner to see the changes.  
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Forms 
 

• Menu bar 
• Tool bar (Vertical and Horizontal) 
• Title bar 
• A navigation frame that lists all available options for navigating from the current block. 
• Iconics buttons 
• Blocks of information 
• The ability to open more than one form at the same time. 
• Auto Hint 
• Status Line 

 
 
 

Key Block 

Icon Buttons 

Other 
Block 

Navigation 
Frame 

Field with 
Validation 
Table 

 
 
What can you do with a Form 
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A form is where you enter and/or look up information in Banner.  A form has one or more 
windows. 
 
What is a window? 
 
A window is a framed, rectangular area within a form.  A Banner form can have one or more 
windows.  This first window in a form is called the main window.  Any other windows in the 
form are called additional windows. 
 
Window Pane 
 
A window pane is an area that has more fields than can appear in the window at one time.  A 
solid line usually borders the pane. 
 
 

Window 
Pane 

Another 
Window 
Pane 

Horizontal 
Scroll Bar 

 
 
A horizontal scroll bar always appears under a window pane. 
 
Types of Forms 
 
Main menu  Use this form to navigate through Banner2000. It provides an overview of the 
menus, forms, jobs and QuickFlows in the system.  
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Application forms  Use these forms to enter, update, and query information. This is the most 
common type of form. 
 
Validation forms    Use these forms to define the values unique to New Mexico Highlands 
University that can be entered in specific fields on application forms. These values are used 
throughout Banner2000. When you look up a code or select the List function, these values 
appear in the List of Values window. 
 
Rule forms    Use these forms to define the calculations and parameters that impact processing 
on other forms, reports, and jobs. 
 
Control forms    Use these forms to define the processing rules for application and validation 
forms at the system level. 
 
Query forms    Use these forms to look up existing information, often returning information to 
the calling form. You must access these forms from another form. You cannot access them 
directly from the main menu, with Direct Access, or with Object Search. 
 
Inquiry forms    Use these forms to look up existing information, often returning information to 
the calling form. You can access these forms from the main menu or from another form, with 
Direct Access or with object search. 
 
Wizard forms  Used to give step-by-step instruction for completing an application. 
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Examples of Forms 
 
Application Form 
Application forms are used to enter, update, and query information.  Each application form has a 
specific purpose, much like paper forms that are used within an office. An example of an 
Application form is SPAIDEN: 
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Inquiry Form 
 
Inquiry forms are used to look up existing information, often returning information to the calling 
form.  You can access an inquiry form from the main menu, from another form, with Direct 
Access, or with Object Search. 
 

 

 
The Function Attendance Inquiry Form (GEIATTD) is an example of an inquiry form.
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Query Form 
 
Query Forms are used to look up existing information often returning information to a calling 
form.   You must access a query form from another form.  You cannot access it directly from the 
main menu, Direct Access or with Object Search.  An example of a Query form is SOQHOLD 
(Holds Query-Only Form). This form is called by SHADEGR.  On this form, you can enter as 
much information regarding the person as possible.  Hint:  The more you are able to enter about 
a person, the more precise the search will be. 
 

 
 

The Holds Query-Only Form (SOQHOLD) is an example of a query form.
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Validation Form 
 
Validation forms are used to define values that can be entered in specific fields on application 
forms.  These values make up a List Of Values (LOV).  STVATYP shows the valid address 
types used at New Mexico Highlands University throughout the Banner system. 
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Wizards Form 
 
Wizards are used to give step-by-step instructions for completing an application. 
 

 

 
The Wizard Step Setup Application Form (GOADSTE) is an example of a wizard form. 
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Menu Bar 
 
The Banner2000 menu bar, located at the top of every form, contains pull-down menus to allow 
you to navigate through the system. 
 

 
 
Note: If a pull-down menu name is dimmed, the menu is disabled and cannot be accessed.  You 
can access an option in a pull-down menu at any time, except when you are in a dialog box, alert 
box, or List of Values (LOV). (You must respond to these windows before you can access a pull-
down menu.) 
 
For example, click on Block: 
 

  

 
 

This pull-down menu contains the functions used to navigate among the Blocks of information 
on a form. 
 
File Menu 
 
This pull-down menu contains standard Banner2000 and Oracle functions. The bottom of the 
menu lists the last forms (up to ten) you accessed in this session. You can select any form in this 
list to re-access it. 
 
Some of the menu items let you call another form, job, or QuickFlow. When you exit the called 
object, you return to the object you were previously using. 
 
Direct Access Displays the Direct Access Form (GUAPARM), which is used to access a form by 
its seven-character name.  
 
Object Search Displays the Object Search Form (GUIOBJS), which is used to search for a menu, 
form, job, or QuickFlow with part of the name, description, or type.  
 
QuickFlow Displays the QuickFlow Form (GUAQFLW), which is used to access a QuickFlow. 
 
Select Returns you to the calling form and enters the selected value into the field that called the 
form. 
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Rollback  Application and inquiry forms 
Clears all information (except key information) and returns you to the first 
enterable field in the key block. 
Validation forms 
Returns you to the first enterable field on the form. 
Query forms 
Returns you to the first enterable field on the calling form 

 
Save Saves all changes entered since the last time you saved. 
 
Refresh Clears the message line. 
 
Print Prints the current window with the date and time in the title bar. 
 
Exit   Forms and windows 

Exits you from the form or window. 
Main menu 
Exits you from Banner2000. 
Query mode 
Cancels the query and takes the form out of query mode. 

 
Exit QuickFlow Exits you from a QuickFlow. 
 
Preferences Displays the Personal Preferences Maintenance Form (GUAUPRF), which is used to 
customize Banner2000 for individuals. 
 
List of recently accessed forms 
Lets you quickly re-access forms that were previously accessed in this session (up to ten).  
 
Edit Menu 
 
This pull-down menu contains the functions used to edit text items. 
 
Cut Cuts selected text and places it on the clipboard. 
 
Copy Copies selected text to the clipboard. 
 
Paste Pastes text from the clipboard to the spot where the cursor is located. 
 
Edit Displays the Editor window, which is used to enter or update text.  You can display this 
window from most fields. It is particularly useful in long data fields.  
 
Block Menu 
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This pull-down menu contains the functions used to navigate among the blocks of information on 
a form. 
 
Previous Moves the cursor to the previous block that has at least one enterable field. If the 
previous block is in another window, that window is opened. 
 
Next Moves the cursor to the next block that has at least one enterable field. If the next area is in 
another window, that window is opened. 
 
Clear Clears all information from the current block on your display. (Information is not removed 
from any records or tables.) 
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Field Menu 
 
This pull-down menu contains the functions used to navigate among the fields or items on a 
form. 
 
Previous Moves the cursor to the previous enterable field in the current block. 
 
Next Moves the cursor to the next enterable field in the current block.  Occasionally, Next Field 
moves the cursor to the first enterable field in the next block. 
 
Clear Clears all information from the current field on your display. (Information is not removed 
from any records or tables.) 
 
Duplicate In a blank row of a repeating record, duplicates the contents of the same field in the 
previous record and copies it into the new record. 
 
Record Menu 
 
This pull-down menu contains the functions used to work with records on a form. 
 
Previous Moves the cursor to the first enterable field in the previous record and triggers previous 
record logic coded into the form. 
 
Next Moves the cursor to the first enterable field in the next record of the current block and 
triggers next record logic coded into the form. If the cursor is in the last record, a new record is 
created. 
 
Scroll Up Scrolls up the list of repeating records, putting the first displayed record near the 
bottom of the list. 
 
Scroll Down Scrolls down the list of repeating records, putting the last displayed record near the 
top of the list. 
 
Clear Clears all information from the current record on your display. (Information is not 
removed from any records or tables.) 
 
Remove Removes all information for the current record. When you Save, the removed 
information is deleted. 
 
Insert Inserts a new blank record into the list of existing records. 
 
Duplicate Duplicates the contents of all fields in the record and copies them into a new record. 
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Lock Temporarily locks the contents of the record so no other Banner2000 user can update it. 
Save, Rollback, and Exit release the lock. 
 
Query Menu 
 
This pull-down menu contains the functions used to query information in the database based on 
specified criteria. 
 
Enter Puts the form into query mode so you can enter search criteria to see what information is 
already in the database. 
 
Execute Searches the database and displays the first set of records that match your search criteria. 
 
Last Criteria Enters the criteria from your last search (enabled only when you are in query 
mode). 
 
Cancel Cancels the query and takes the form out of query mode. 
 
Count Hits Counts the number of records that match the search criteria and displays that number 
in the auto hint. 
 
Fetch Next Set If more records meet the search criteria than fit in the window, replaces the 
current set of displayed records with the next set. 
 
Help Menu 
 
This pull-down menu contains various help tools, the image displayer, a calculator, and a 
calendar. 
 
Online Help Displays new online information for the current field.   Note: This option is 
disabled if online help is not available for the form. 
 
Dynamic Help Query Displays the Dynamic Help Form (GUAHELP) in query mode, which is 
used to display traditional help for a field, block, or form. 
 
Dynamic Help Edit Displays the Dynamic Help Form (GUAHELP) in edit mode, which is used 
to edit traditional help for a field, block, or form. 
 
Banner2000 Bookshelf Provides electronic access to hardcopy documents in the 
Banner2000 Bookshelf.  
 
Help (Item Properties) Displays the Oracle item properties window for the current field. 
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Show Keys Displays the Keys list, which lists the functions and their equivalent keystrokes 
available in your environment for the current form, window, and field. 
. 
List Displays the List of Values (LOV) for the current field if List of Values appears in the status 
line.  
 
Display Error If an Oracle error occurs, displays the code that is in error. 
 
Display Image If the cursor is in an ID field, displays the image associated with the ID, if 
available. Calendar Displays the calendar.  Calculator Displays the calculator. 
 
About Banner2000 Displays the About Banner2000 Form (GUAABOT), which identifies the 
current form, release number, date, and time. 
 
Windows Menu 
 
This pull-down menu, available only in Microsoft Windows environments, lets you arrange the 
open windows of a form. 
 
Cascade Arranges each open window in a cascade. 
 
Tile Arranges each open window in a tiled format. 
 
Arrange Icons If an open window is collapsed into an icon, lets you move the icon. 
 
Open windows Lists each currently open window in the active form. A checkmark identifies the 
active window. You can make another window active by clicking the window name or entering 
the window number. 
 
Using the Toolbars 
 
Toolbars are sets of iconic buttons that perform common functions. Banner2000 has two 
toolbars: 
 

• The horizontal toolbar appears directly under the menu bar. This toolbar is delivered with 
standard buttons. 

• The vertical toolbar appears on the left side of the screen. 
 
Use the Horizontal Toolbar to navigate through the Banner system and perform most common 
functions. 
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When you move your cursor to an iconic button and pause, a yellow bubble appears with text 
that describes the function of the button. 
 

Icon Action Keystroke Menu Bar Description 

 Save/Commit F10 File > Save Commits or Saves Data 

 Rollback or Clear Form Shift+F7 File > Rollback Return cursor to Key Block or top 
of the form 

 
Select Shift+F3 File > Select Selects value into the field 

 Insert Record F6 Record > Insert  Inserts a new record 

 Delete Record Shift+F6 Record > Delete Deletes record 

 Enter Query F7 Query > Enter Begins query or search 

 Execute Query F8 Query > Execute Executes a query or search 

 Cancel Query Ctrl+q Query > Cancel Cancels a query or search 

 Previous Record Shift+Up Arrow Record > Previous Shows previous record 

 Next Record Shift+Down Arrow Record > Next  Shows next record 

 Previous Block Ctrl+PageUp Block > Previous Moves cursor to previous block 

 Next Block Ctrl+Page Down Block > Next  Moves cursor to next window or 
block 

 
Print Shift+F8 File > Print Prints a screen shot 

 Show Keys Ctrl+F1 Help > Show Keys Shows Function Keys 

 Exit Ctrl+q File > Exit Closes or Exits from a form 
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The Vertical Toolbar 
 
The vertical toolbar appears on the left side of the screen.  The vertical toolbar contains the 
custom iconic buttons.  You can customize this part of the tool bar to meet your specific needs.  
For example a calculator, calendar and web browser can be included. 
 
 

 

Calculator 
Calendar 
 
 
Microsoft Office 
 
 
 
Internet 
 
Banner Help 
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Calendar and Calculator 
 
You can double-click any date field to display the calendar. If the date field has a value, the 
calendar highlights that date. If the date field is empty, the calendar highlights the current date. 
You can double-click a date on the calendar to return it to the calling form. 
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You can double-click any numeric field to display the calculator. If the numeric field has a value, 
the calculator shows that value. You can use the mouse, number keys on the keyboard, or the 
numeric keypad (if the NumLock is enabled) to make calculations. When you’re done, click the 
OK button to return the calculated value to the calling form. 
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Form Buttons 
 
Buttons are visual images used to perform an action or respond to the system. 
 
Banner2000 forms use iconic buttons and response buttons. 
 
Iconic Buttons 
 
These buttons are small squares that contain an icon (picture). They represent one or more 
actions that can be performed for the associated field or record. For example, you can use iconic 
buttons to display a validation form for the field, copy a record, and display a window for 
entering freeform text. 
 
Banner2000 forms use the following iconic buttons. (Some products do not use all buttons.) 
 

Icons Buttons 
 
 
 

 
 
 

 
 
 

 
 
 

  
 
 

 
 
 

 
 
 

 
SEARCH – Indicates a full – screen 
List of Values (LOV)– searchable field. 
 
DATA – data is available for this field. 
 
 
NO DATA – no data is available for 
this field. 
 
SUMMARY – displays summary 
information for this record. 
 
DETAIL – displays detail for this 
record. 
 
COMPLETE – the process is complete. 

 
 
 

 
 
 

 
 
 
 

 
 
 

 
 
 

MAINTENANCE – indicates a 
maintenance function (such as Generate) 
is available. 
COPY – copies the current record or 
copies a document. 
 
COMMENTS - displays a window 
where you can enter freeform text for 
the associated record. 
 
CALCULATE – performs a calculation 
on data in the field. 
 
APPROVE – approves the document. 
 
 
DISAPPROVE – disapproves the 
document. 
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Response Buttons  
 
These buttons are shaded rectangles that appear in alert boxes and dialog boxes. An alert 
box has one response button. A dialog box has two or more response buttons.  You must 
use the buttons to respond to the system before you can continue. 
 

Alert Box 

 
 

Dialog Box 

 
 

 
Radio Buttons 
 
Radio buttons is a response button which are small circles used to select one of several 
options in a group.  Each button represents a choice for a group.  You may only choose 
one Radio Button in a group. 
 

 
 
Check Boxes 
 
Check Boxes, such as the Dual Degree indicator are selected or deselected.  There are 
also Check Boxes that indicate action has been taken or requirements have met specific 
rules set up in Banner.  These boxes, such as in the Outstanding Requirement field, are 
indicators only and cannot be edited. 
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Navigation Frame (Options) 
 
The navigation frame on the left side of a form shows the navigational options.  The 
options depend on the current location of the cursor. Some options take you to other 
blocks and windows within the current form. Other options take you outside the current 
form to other related forms. 
 

 

The Options menu shown is from form FPIPURR.  
Click on the Options to move through the Information 
Blocks on FPIPURR or to navigate to other related 
forms.  When the  Scroll Buttons are black, there are 
more options than can be viewed on one page: 

Click on the Down Scroll Button 
on the right side to view additional options.  When the 
Scroll Buttons are gray, the only Options available are 
those you see on one page:  
 
A Help bubble appears when you move the cursor 
over an option that takes you outside the form. 

 

 
Fields 
 
Note: A field is sometimes called an item. This is the case in the names of the functions 
Next Item, Previous Item, and Duplicate Item. 
Fields are areas on a form where you can enter, query, change, and display specific 
information. The following terms describe a field: 
 

• Enabled. You can put the cursor in the field. Information in the field appears in 
black text. 

• Disabled. You cannot put the cursor in the field. Information (if it exists) appears 
in gray text. 
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• Enterable. You can enter information in the field. The field is usually enabled.  In 
certain situations, however, it may be disabled. 

• Display only. You cannot enter information in the field. 
 
The color of some field names is BLUE.  This means that there is a Validation Table that 
can be accessed from that field for a valid list of entries.   
 

 
 
There is a Validation form for the Citizen, Ethnic, Marital, Religion, and Legacy fields on 
the above form. 
 
Searching the Database 
 
Banner search forms allow you to search by name, by id, or if you are unsure of the 
spelling, or if you only know part of the name. 
 

If you want to search for a person, click on the Search icon  after the IDfield: 

 

This will take you to a search form.  All search forms, whether you are searching for a 
person or id, perform the same way.  When you enter the form, it will be in query mode.  
This means that it’s ready for you to enter any information that will assist Banner to 
locate the record.  For example, to find the record of John T. Roth, the best search would 
include Roth in the Last Name field and John in First Name.  That would return all the 
John Roths  that exist within the database.  If more than one exists, then you could view 
the records and select the appropriate one.  This is a very precise search.  You have 
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specified a First and Last name.  Very few records should be returned from your search.  
Many times, unless it’s a very common name, this type of search will bring back only the 
record you desire. 
 
If you do not enter such a precise search and only enter Roth in Last Name and no 
information in First Name or Middle, the system would return all Roth records that exist 
within the database.  The rule of thumb is: the more information you provide for the 
search, the fewer the records you must view to find the one you desire.  
 
If you do not want to do a Case Sensitive search, change the default "Yes" by clicking the 
"No" Radio Button at the bottom of the form: 
 

 
 
Although at NMHU we use mixed case to enter names (i.e., Roth instead of ROTH or 
roth), it would be wise to click "No" to search for names like McDonald. 
 
Wildcards % 
 
Sometimes, you don’t know much information about a person, i.e. spelling, complete 
name, etc.  In that instance, you can use a special symbol known as a wildcard, along 
with as much information as you know to perform the search.  Banner uses the wildcard 
symbol, %, to stand for one or more characters.  Banner uses the wildcard symbol, _, to 
stand for one character only. 
 
Example: Suppose you would like to find the record for a person whose last name is 
Kelley and first name is Sally.  However, you are unsure if the last name is spelled Kelly 
or Kelley, you can enter Kell% in the Last Name field and Sally in the First Name field.  
Banner will return records whose Last Name begins with Kell AND whose first name is 
Sally.  Therefore, you would see records for Sally Kelly; Sally Kelley; Sally Kellogg; 
etc., because the records matched the criteria.  
 
More Examples of Wildcards 
 
To get these results Enter this criteria 
All entries that contain ma %ma% 
All entries that begin with ma ma% 
All entries that have ma as the final two 
characters  

%ma 

All entries that have m as the second 
character 

_m% 

 
 
Executing Queries 
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Once you have entered the information and would like to search the database, you must 
execute the query.  There are several ways to do this: 

Click on the Execute Query button on the Toolbar  
Use the keyboard command for Execute Query (F8).  
Click on the Query pull down menu, and then select Execute.  
 
Searching:  The Basics 
 
Enter a query form either by typing the inquery form name at the menu prompt or by 

clicking on a Search Light .  
 
Enter the information in the appropriate fields of the query form.  Enter enough 
information to narrow down the list of records to a manageable size.  You can use the 
wildcard if some information like spelling is unknown. 
 

Execute the query .  
 

If you do not get the desired results, click on the Rollback  button. The form will be 
cleared and reset in query mode for you to try again!  
 

Click the Select button  to return the desired record back to the calling form.  
 
Multiple Records of Same Name  
 
If your search for Judy Johnson returns multiple records, click "Search and Display More 
Detail". 

 
 
This will take you to a detailed search form, Execute a Query, and you will retrieve detail 
records of all of the Judy Johnson in the database. 
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Highlight the record you wish to retrieve, and click Select  or double click on record 
to return to the calling form (Note that the record we wanted was Judith, instead of Judy). 
 
Auto Hint and Status Bar 
 

 
 
The auto hint at the bottom of the form can contain the following information for the field 
where the cursor is located: 
 

• Brief field description  
• Error and processing messages  
• Keyboard equivalents, if you can access other blocks, windows, or forms from the 

field 
 
Tip:  If you have typed something that is not allowed in the field, read the message on 
the Auto-Hint line.  To clear the message, select the Help key once, this will re-display 
the original information about that field. 
 
The status line directly under the auto hint can contain one or more of the following 
messages: 
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• Record n/n:  Shows the number of the current record followed by the total 

number of records in the current block.  If there are more records than fit in the 
windows, the total appears as a question mark (for example, 1/?) until you scroll 
to the last record in the block.  Once the last record is displayed, the total appears 
as a number (for example, 1/15). 

• List of Values:  Indicates the field had a List of Values (LOV). 
• Enter Query:  Indicates the form is in query mode. 

 
How to Change Your Password in Banner 
 

1. Double click the Banner icon on your desktop. When Banner's opening screen 
appears (below), type GUAPSWD in the Direct Access box on the Main Menu in 
Banner and press the ENTER key on your keyboard. 

 
The Oracle Password Change Form (GUAPSWD) will appear on the screen. (Below) 
 

 
 

2. In the Oracle User ID field enter your Username, if it is not already in the field. 
3. In the Oracle Password field, enter your current Banner password. 
4. In the Database field, enter the name of the database, if it is not already in the 

field. 
5. In the New Oracle Password field, enter your new password. 
6. In the Verify Password field, re-enter your new password and press the Save 

button. 
 
When successful the following message will be displayed: 
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Click OK. You have successfully changed your password. 
 
Password Security  
 

• Access is a privilege granted to you; please use it responsibly.  
• Never share your password.  
• Never allow anyone to logon to or use your username.  
• Don't even share a password with your supervisor.  
• Avoid writing your password down. 

 
Banner Problem Reporting 
 
If you experience a problem with Banner2000, report the problem to the CNSgroup: 454-
3496. 
 
You should provide the Help Desk with the following information: 
 
Your Banner Username   
Description of the problem  
Any form names (e.g. SPAIDEN) that are involved   
Any error numbers (ORA-00942) if available   
Go to the pull down menu Help, then do a Display Error   
What were you attempting to do that triggered the error?   
Is it an isolated incident?   
Priority: Critical, Can Work Around, Low 
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Form Naming Conventions  
 
Banner2000 forms, reports, jobs and tables have seven-character names with the 
following structure:  
 

A  Alumni/Development  L  Occupational         
Tax/License  

U  Utilities  

B  Property Tax  N  Position Control  V  Voice Response  
C  Courts  O  Customer Contact  X  Records Indexing  
D  Cash Drawer  P  

HR/Payroll/Personnel  
F  Finance  Q  Electronic Work 

Queue  
G  General  R  Financial Aid  
I  Information Access  S  Student  

Position 1 

Identifies the primary 
system owning the form, 
report, job or table.  

K  Work Management  T  Accounts Receivable  

W, Y, Z   Reserved for 
client applications that 
co-exist with Banner 
2000  

General (G)  Student (S)  Finance (F)  
E  Event Management  A  Admissions  A  Accounts Payable  
J  Job Submission  C  Catalog  B  Budget Development  
L  Letter Generation  E  Support Services  C  Cost Accounting  
O  Overall  F  Registration/Fee 

Assessment  
E  Electronic Data 
Interchange  

P  Purge  G  General Student  F  Fixed Assets  
S  Security  H  Grades/ Academic 

History  
G  General Ledger  

T  Validation form/table  I  Faculty Load  I  Investment 
Management  

U  Utility  K  Reserved for SCT 
Intl. - UK  

O  Operations  

X  Cross product  L  Location Management  P  
Purchasing/Procurement  

Accounts Receivable (T)  M  CAPP  R  Research Accounting  
F  Finance Accounts 
Receivable  

O  Overall  S  Stores Inventory  

G  General Accounts 
Receivable  

P  Person  T  Validation form/table  

O  Overall  R  Recruiting  U  Utility  
S  Student Accounts 
Receivable  

S  Schedule  

T  Validation form/table  T  Validation form/table  
U Utility  U  Utility  

X  Archive/Purge  

Financial Aid (R)  HR/Payroll/Personnel 
(P)  

Position Control (N)  

Alumni / Development 
(A)  

B  Budgeting  A  Application  A  Membership  
C  Record Creation  B  Budget  D  Designation  
E  Electronic Data 
Exchange  

C  COBRA  E  Event Management  

F  Funds Management  D  Benefits/Deductions  F  Campaign  
H  History and 
Transcripts  

E  Employee  G  Pledge and 
Gift/Pledge Management  

Position 2 

Identifies the module 
owning the form, report, 
job or table.  

J  Student Employment  H  Time 
Reporting/History  

M  Prospect 
Management  
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L  Logging  O  Overall  O  Organization  
N  Need Analysis  P  General Person  P  Constituent/Person  
O  Common Functions  R  Electronic Approvals  S  Solicitor Organization  
P  Packaging & 
Disbursements  

S  Security  T  Validation form/table  

R  Requirements 
Tracking  

T  Validation/ rule table  U  Utility  

S  Student System Shared 
Data  

U  Utility  X  Expected Matching 
Gift  

T  Validation form/table  X  Tax Administration  Information Access (I)  
U  Utility     S  Student  
      R  Financial Aid  

All Products 

 

W, Y, Z  Reserved for client forms or modules used within a Banner2000 
application (character in position 1 does not equal W, Y, or Z)  

   

General (G)  Student (S)  Finance (F)  
A  Application Form  A  Application Form  A  Application Form  
B  Base table   

Batch COBOL process  

B  Base table   B  Base table   

I  Inquiry form  I  Inquiry form  I  Inquiry form  
O  Online COBOL 
process  

P  Process  M  Maintenance form  

Q  Query form  Q  Query form  Q  Query form  
R  Rule table  

Repeating Table  

Report/process  

R  Rule table  

Repeating Table  

Report/process  

R  Rule table  

Repeating Table  

Report/process  
T  General maintenance  

Temporary table  

V  Validation form/table  

View  

V  Validation form/table  

View  
V  Validation form/table  

View   

      

Accounts Receivable (T)  
A  Application form  P  Process  R  Report  
I  Inquiry  Q  Query  V  Validation form/table  

Financial Aid (R)  HR/Payroll/Personnel 
(P)  

Position Control (N)  

Alumni/Development 
(A)  

A  Application form  A  Application form  A  Application form  
B  Base table  B  Base table  

Batch COBOL process  

B  Base table  

I  Inquiry form  I  Inquiry form  C  Called/list form  

Position 3  

Identifies the type of 
form, report, job, or 
table.  

P  Process/report  P  Process  I  Inquiry form  
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R  Rule table  

Repeating Table  

Report/process  

R  Rule table  

Repeating Table  

Report/process  

P  Process/report  

T  Temporary table  V  Validation form/table  R  Repeating rules table  
Information Access 

 

V  Validation form/table  

View  
R  Report  

V  Validation form/table  

View  
Positions 4, 5, 6 and 7 uniquely identify the form, report, job, or table.  
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For example, 
 

F  
  

O  
  

A  
  

I  
  

D  
  

E  
  

N 

1 2 3 4 5 6 7 
 

Using the structure shown above, FOAIDEN is a Finance (position 1), Operations 
(position 2), Application (position 3) form that has an English-like name of IDEN which 
stands for Identification.  Likewise, SPAIDEN is a Student (position 1) Person (position 
2) Application (position 3) form that has an English-like name of IDEN which stands for 
Identification.   

More Examples:    

                      SHRROLL  
S  Student  
H  Grades/Academic History  
R  Report  
ROLL  Grade Roll  

 

                      STVSTAT  
S  Student  
T  Validation form/table  
V  Validation form/table  
STAT  State/Province Code  
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Short Cut Keys 

Key(s) Function 
F10 Save 
Shift F7 Rollback 
Shift F3 Select 
F6 Insert Record 
Shift F6 Delete Record 
F7 Enter Query 
F8 Execute Query 

Ctrl Q 
Cancel 
Query/Exit 

Shift F8 Print 
Ctrl PageUp Previous Block 
Ctrl Page 
Down Next Block 
Ctrl Q Exit 

  
 
 


